
Erase Selected Channel Data : From the [Tools] Menu

1. Put a check on the channel number you wish to erase.

2. Click the [OK] button to complete the deletion. 

[OK]
button

Check 



Set Vertical Axis Display Range: From the [Tools] Menu

It is possible to set the upper and lower values of the vertical axis scale for each channel.

NOTE:

- In this case, the data graph lines may under certain circumstances stick out of the graph.

- Settings for the upper limit must be lower than 40,000 and settings for the lower limit must be higher 
than –40,000.

1. Put a check next to <Fixed> for the channel you wish to make settings for. 

Make all settings same as 
Ch. 1 OK

button

Check <Fixed> and 
enter the desired 
numerical values.

2. Enter the Upper and Lower Limits.

3. Click the [OK] button to fi nish the setting process.



Make all settings same as Ch. 1

If you have chosen fi xed values for Ch.1 and put a check next to [Make all settings same 
as Ch. 1], the settings will become the same for all other channels whether that channel 
has been set to Fixed  or Auto .

Scale / Unit Conversion: From [Tools] Menu

It is possible to make settings for the conversion of units and scales for each channel of 
downloaded data.

1. Select to use 2 voltage points to convert the scale or to use the conversion equation of 

y=Ax+B.

Conversion Info

[OK]
button

Designate by 2 points

y=Ax+B

2. Make settings for the conversion equation and unit.

3. Click the [OK] button to fi nish the setting process.

Conversion Info

The currently set conversion equation and the character array of the current unit will be 
displayed.

By stands for the value after conversion and x is the voltage input directly from the sensor.



Change Graph Colors : From the [Tools] Menu

1. Click the channel number or item for which you wish to make changes. 

If you wish to change the color: click the appropriate button to view the color selection samples.
If you wish to change the type of line: click the [Line Type] button to view the line type selections.
If you wish to make changes to the width of the lines: In the image preview display, fi rst click on 
a channel number button to select the channel and then each click of the  button will make 
that channel s line wider and each click of the  button will make it thinner. 

Color Sample
Change Line Type

[Close]
button

Image 
Preview

memo

[Channel No.]
button

[Default]
button

*If you wish to make changes to the graph colors, line types, or line widths, click on the [Channel No.] 
button fi rst and then click on the topic you wish to make changes to.



2. After confi rming the color in the image preview display, click the [Close] button to 

complete the changes. 

*By clicking the [Default] button, you will return to the color settings to the Default settings.

memo

Here it is possible to save one pattern of settings for use in the display and one for use 
when printing .

1. Select [Display] or [Print].

2. Click the [Save] button to save the settings.

For Display
For Printing

[Load]
button

[Save]
button

By clicking the [Load] button, you can call up a saved pattern.



Operating the Graph Display

Returning to Original Size

Return from zooming in on one part of data to the original whole graph size.

Zoom out step by step

Return by regular steps from zooming in on one part of data to show larger ranges of data.



How to Operate the Event Viewer

How to Open

From the list of programs in the Window’s Start Menu, click on "RTR-5W for Windows" - "Event 

Viewer"

Using Help

For details about how to use the software, please see the explanations in the Software Help 

Menu.

-In the Menu Bar, click  [Help] - [Search by Topic], then click on one of the tabs [Contents],  [Index], or 
[Search] to search for the topic or term you are unsure about or have questions about.

[Contents] 

By clicking on one of the topics listed, you can fi nd detailed information for that subject. 

[Index]

By selecting a Keyword in the Keyword list, and clicking the [Display] button at the bottom, a 

detailed explanation will appear. 

[Search] 

Enter the keyword you wish to search for and click the [List Topics] button. All topics that contain 

the keyword will be displayed.  By selecting a topic and clicking the [Display] button at the 

bottom, a detailed explanation will appear. 

-By clicking the help button in a dialog box, an explanation for that dialog box will appear

-In the Graph Window, by clicking on the  in the toolbar, you can have short explanations 

appear the next time you click on a menu, an icon, or anything in the main window. 



Event Viewer Display Part Names and Functions

With Event Viewer you can view Recorded Event Time Data in a List (up to 64 channels), Print 

the List, or Save as Text File.

Menu Bar

Menus are lined up which contain various commands. They are used to view data or to make 

settings for the various functions in each menu.
Icon: View only rising edge data This includes when there was a simultaneous occurrence of rising and falling.

 Icon: View only falling edge data.This includes when there was a simultaneous occurrence of rising and falling.

 Icon: View all Data 

Toolbar

Buttons appear for frequently used commands.

Button for Moving Vertical Axis

Click the arrow buttons to move up or down.

Scroll Bar

By dragging the Scroll Bar you can move up and down to the desired position.

/ /

View rising (Lo to Hi) waves,  falling (Hi to Lo) waves, or both types



Change the Event Viewer Method of Display 

Shift Display: From the [View] Menu or the Toolbar

You can shift the display to view either by the recorded date/time or by the elapsed time from the 

last recorded data.

Recorded Date 
Display

Elapsed Time 
Display

Shift Descending / Ascending: From the [View] Menu or the Toolbar

You can shift the display to view the recorded data either from the newest to the oldest or from 

the oldest to the newest.



File Info: From the [View] Menu

View fi le info about data in the currently displayed data list.

File Name: File names of the data fi les currently displayed in the data list.

Path: The Location where the File is saved

Date Created: The date and time when the data fi le was created.

CH. Info Channel No. / Recording Mode / No. of Data Readings



Print Preview and Print

Preview only that data which was selected and print. 

1. In the [File] Menu, select [Print Preview and Print] 

2. In the [Select Channel for Printing] File list, select the channels you wish to print and 

click the [OK] button.

[OK]
button

3. The [Print Preview] will be displayed.After confi rming, click the [Print] button to start the 

printing.

Button Functions

[Print]: the [Print] box will appear and printing will begin.

[Previous]: Preview the previous page.

[Specify P]: Specify the page you wish to preview in the [Specify Page to be Viewed] box and a 

preview of that page will appear. 

[Next]: Preview the next page.

[Reduce]: Reduce the size of the displayed page.

[Enlarge]: Enlarge the size of the displayed page.

[Close]: Close the Print Preview Window and return to the Main Window.



Saving Recorded Data

If you have edited any graph displayed data we suggest that you save it as necessary.

3 Ways to Save Files

-In the [File] Menu, select [Overwrite All Data]

Will save any changes to fi le without changing File Name and Saving Location.

The same operation can be carried out from [Save] in the Toolbar.

-In the [File] Menu, select [Save All Data as...]

Save with a new File Name.

-In the [File] Menu, select [Save Displayed Data]

Save only that data in the current display.This is handy when you wish to save only the desired 

data.

EX: [Save All Data as...]

1. Click [Save All Data as...] in the [File] Menu.

2. Specify the [Location] and enter a [File Name].

3. Click [Save] to complete the saving process

[Save]
button

Assign a 
Location

Enter a File 
Name



For Event Viewer

When using Event Viewer only [Save Data as ] can be used. 

1. Click [Save Data as...] in the [File] Menu.

2. Specify the [Location] and enter a [File Name].

[Save]
button

Assign a 
Location

Enter a File 
Name

3. Click [Save] to complete the saving process



Creating Text File

By saving the recorded data as text fi le, you can create a fi le type that can be read by 
common spreadsheet software.

1. Click [Save in Text File] in the [File] Menu.

2. Select the [Text File Type] and [Range to be Saved], and click [OK].

-Comma, Tab, Space, and Semi-colon are codes used by common spreadsheet software, such 

as Excel and Lotus, when reading Text File to divide cells.

3. Designate the location to which the fi le should be saved and click [Save] to create and 

save the data as a Text File document.

[OK]
button

Select the Range 
to be Saved

Select the Text File Type

-The extension for the created fi le will be [.txt].

* Text File cannot be read into [Temp / Humidity Graph] or [Multi-scale Graph]

[Save]
button

Assign a 
Location

Enter 
a File Name



For Event Viewer

1. In the [File] Menu, click [Save in Text File] .

2. Select the [Text File Type], click [Specify File] button and specify the saving location.

*Comma, Tab, Space, and Semi-colon are codes used by common spreadsheet software, such as 
Excel and Lotus, when reading Text File to divide cells.

[OK]
button

Select the Text File Type

[Designate File]
button

File Name and Location

3. Click the [OK] button to fi nish the creation of the text fi le document. 

-The extension for the created fi le will be [.txt].

*[Event Viewer] cannot read text type fi les.



Opening a Saved File

To open a previously saved fi le, designate the fi le name to open it.

1. Click [Open] in the [File] Menu of the Graph Display.

2. Select the name of the data you wish to open and click [Open] to view the data in graph 

form.

[Open]
button

Select a data fi le to 
open

For Event Viewer

1. Open Event Viewer

2. In the [File] Menu of the Event Viewer display select [Open File] and a list will appear. 

Select a data fi le to 
open

[Open]
button



Auto-Download Settings

Make settings here to automatically download data from the selected Remote Units at the 
specifi ed time.

1. Open [RTR-5W for Windows].

2. Select the Remote Unit(s) you wish to make settings for, and in the [Registration /

Administration] Menu click on [Remote Unit Properties].

*By right clicking on the selected Remote Unit icon(s), a popup menu will appear where you can select 
[Remote Unit Properties] to display the same window. 

3. Select to download [Every day at a fi xed time] or [Fixed Interval] and make the 

appropriate settings. 

-Every day at fi xed time (24 hour clock)

 Carry out the downloading of data automatically at a set time every day

-Fixed Interval 

 Carry out the downloading of recorded data automatically at a set interval of 

time.(Make setting for 10 days or less) 

4. Click the [OK] button to fi nish the setting process.

Make settings 
for the interval 

between 
downloads

Make settings 
for the time of 

download.

NOTE:

-Make sure that RTR-5W for Windows is open when a programmed Auto-Download is 
scheduled to occur. 

-If, another type of communication, such as a warning monitoring, occurs at the scheduled 
downloading time and downloading is not possible, downloading will begin upon the ending of 
the other communication. 

-Depending on radio wave conditions, data downloading may at times be impossible. Please 
check in the downloading log for important data.

-If the recording mode is set for One Time and the logger becomes full, you may be 
downloading the same data over and over again 



If you wish to Stop the Auto Downloading

Select the Remote Unit(s) for which you wish to stop downloading, under the Auto 
Downloading settings put a check next to [Not to be carried out], and click the [OK] button. 

Programmed Auto Download: From ([View] – [Programmed Auto Download])

If a Remote Unit is set for Auto Download, this will show the time of the next scheduled 

download. 

If, another type of communication, such as a warning monitoring, occurs at the scheduled 

downloading time and downloading is not possible, downloading will begin upon the ending of 

the other communication. 

Viewing the Auto-Download Log: From ([View] – [View Log])

Here, it is possible to view the date and time when Auto-Download settings were made, when 

an Auto-Download occurred, when settings were lifted and other communication results in a log 

form.

The logs are in CSV format which can be read by common spreadsheet software and saved as 

text fi le. 



Warning Monitoring

Warning Monitoring is carried by setting the upper and lower limit for each Remote Unit.

1. Open the [Network Settings Utility] and click on [Detailed Network Settings] to display a 

window where settings changes can be made.

2. Make settings for the DNS Server Address  in [DNS Settings] and for the SMTP 

Server Name  in [Warning Report Mail].

Enter SMTP settingsEnter the DNS server address

3. Open [RTR-5W for Windows]

4. Select the Remote Unit(s) you wish to make settings for, and in the [Registration /

Administration] Menu click on [Remote Unit Properties].

*By right clicking on the selected Remote Unit icon(s), a popup menu will appear where you can select 
[Remote Unit Properties] to display the same window. 

5. Check [When operating the warning function, monitor this Remote Unit] , and enter 

values for the upper and lower limits. 

[OK]
button

Enter Upper 
and Lower Limit 
Settings



6. Click the [OK] button to fi nish the setting process.

7. In the [Settings] Menu, click on [Start / Stop Warning]. 

*By right clicking on the selected Remote Unit icon(s), a popup menu will appear where you can select 
[Start / Stop Warning] to display the same window. 

notifi cation address

A sender address

Notifi cation 
Settings

Warnig Monitoring

8. Make the desired settings.

Warning Monitoring
If you wish to carry out the monitoring of warnings, place a check next the [Warning ON] and make 
monitoring interval settings.

*Enter an amount of time between 10 minutes and 1440 minutes. If this interval is short, battery life will 
be depleted quickly. 

Notifi cation Address

Set the recipient address(es) for the Warning Mail.

*If the check is removed, the warning mail will not be sent to that address.

Sender Address

This will only used in the mail display to show where a warning report mail has been sent from.

It should be noted that if you assign an imaginary address, in some cases the SMTP server will judge 
the mail to be SPAM or junk mail and not allow it to be sent. Please use your own mail address. 



Notifi cation Settings

-Amount of send rest time after sending warning report mail

Warning report mail will continue to be sent until the warning settings have been changed or the 
measured value falls back within the acceptable range, but it is possible to make settings here for a rest 
period to occur after a warning mail has been sent, so that they will not continually be sent.  By entering 0, 
there will be no rest period.

-Notify of a communication failure for monitoring warnings

Place a check here if you wish to have communication failure reports sent to the recipient address(es). 

-Switch external output to ON when a warning occurs

If you wish to have an alarm or warning lamp that is connected to the external output go on when a 
warning occurs.

9.  Click the [Set] button to send the settings info to the RTR-5W and complete the 

settings.

[Set]
button

[Notifi cation Test]
button



[Notifi cation Test] button

Use this to send a test mail from the RTR-5W to the notifi cation address and confi rm that the 

warning notifi cation settings are correct. 

A notifi cation test is successful if a notifi cation test mail reaches the notifi cation address. If 

it does not reach the set address, please check the SMTP server, Notifi cation Address, and 

Sender Address settings. 

If you are sending mail via the Internet, it is necessary to fi rst make sure that your network is 

properly connected to the Internet and you can send mail outside of your network. 

Depending on your operating environment, it may take some time before the mail is 

received.(Especially if the address is a cell phone address.)

Before carrying out a notifi cation test, it is necessary to make settings for the 
following: 

-There must be a check next to Warning ON and proper entries must be made for Notifi cation 

Address  and Sender Address .

-In the [Network Settings Utility], the SMTP server (mail server) must be assigned properly. (If 

you have questions, see the information provided by your provider). 

-It should be noted that if you assign an imaginary address, in some cases the SMTP server 

will judge the mail to be SPAM or junk mail and not allow it to be sent. Please use your own mail 

address. 

Viewing the Warning Log: From ([View] – [View Log])

In the warning log will appear all warning occurrences.

Due to timing problems, there may be instances when a warning cannot be stored into the 

computer. For details, see the Help for [RTR-5W for Windows].

The logs are in CSV format which can be read by common spreadsheet software and saved as 

text fi le. 



How to use the RTR-5W Web Viewer

Opening the RTR-5W Web Viewer

1. Open Internet Explorer.

*If you wish to use the Internet, make sure that the power for the router and computer are on so as to 
enable connection to the Internet. 

*Make settings to enable both Java applets and Java script. 

2. In the address area, enter the address of the RTR-5W logger you wish to view.

Enter Address

3. By pressing the [Enter] key, the RTR-5W Web Viewer will appear. 

If the Viewer does not appear

1. Make sure that the address you entered is correct.

2. Check to make sure that the IP address and subnet mask are set correctly and if 

necessary redo the [Detailed Network Settings].  

3. Make sure that in [Location RTR-5W Properties] there is a check next to [Make access 

possible from a browser].



RTR-5W Web Viewer Functions

By opening the RTR-5W Web Viewer, the Monitor Current Readings display will 
automatically open. Also, it is possible to view the Data Transfer Graph for the current 
readings. 

-Monitor Current Readings

The RTR-5W displays the newest measurement readings that are collected at the regular 

interval set in [Location (RTR-5W) Properties].

By clicking the [Gather Current Readings] button, communication will begin with the RTR-5W 

and the current readings will be displayed. 

-Graph

The RTR-5W displays in simple graph form the newest measurement readings that are collected 

at the regular interval set in [Location (RTR-5W) Properties].



Current Readings Monitor (accessing via browser)

View the current readings for all the Remote Units registered to a Location (RTR-5W). 

1. Open [RTR-5W for Windows] and make Data Gathering Interval settings.

-For details about how to make settings see part 4 [Browser Display Settings] of p.40 [Remote 
Registration]

2. Open the Web Viewer for the RTR-5W of which you wish to view the current readings. 

[Gather Current Readings]
button

-See page 99 for more details about the display. 

3. The Monitor Current Readings display will automatically open.

4. Click the [Gather Current Readings] button to get the most recent info. 

*If the registration info is incorrect, go to RTR-5W for Windows [Settings] Menu – [Send Group / Remote Info] 
and send the correct registration info. 



Graph (accessing via browser)

Via the browser, the readings measured by the Remote Unit(s) can be viewed in a simple 
Graph form

1. Open [RTR-5W for Windows] and make Data Gathering Interval settings.

-For details about how to make settings see part 4 [Browser Display Settings] of p.39-41 [Remote 
Registration]

2. Open the Web Viewer for the RTR-5W of which you wish to view the Graph. 

-See pp. 93,94 for more details about the display. 

3. Click [Graph] and select the Remote Unit you wish to view; and the Graph will appear. 

-From [Monitor Current Readings], click the name of the Remote Unit you wish to view; and the Graph 
will appear.

- By clicking the [Show Graph] button, the Graph will be refreshed. 

If any of the following operations are performed, all data in the graph will be erased. 

-If the communication function is restarted from the [Network Settings Utility]. 

- If the AC adapter plug is removed. 

-If the clock settings are made from [RTR-5W for Windows].

-If the RTR-5W is rebooted from [RTR-5W for Windows].

*To view graphs in your browser, it is necessary to have Java Runtime Environment (JRE) installed on your 
computer.

If JRE is not already installed, please download and install it from the Sun Microsystems Homepage. See pp. 
101-103 for details. 



Viewing Current Readings via Mobile Phone

View the current readings via a mobile phone browser for all the Remote Units registered 
to a Location (RTR-5W). 

1. Open the URL entry display and enter the URL for the RTR-5W logger you wish to view 

and press enter. 

2. Select the format that displays best on your phone.

RTR-5W Mobile 

Viewer

Select the mobile phone

carrier you wish to use.

WAP 2.0 Version

WAP 1.0 Version

3. The Current Readings display will appear.

RTR-5W Mobile 

WAP 2.0 Ver

22/03/2006 13:29:57

groupUS

 52A_1

   event

   22/03/2006 13:29:57

   LO

   Falling Edge

 53_1

   28.5[ ]

   22[%]

Refresh using the refresh 

function on your cell phone.

Note:

-To view the current readings monitor via mobile phone, it is necessary to open the RTR-5W to 
the public on the Internet. 

-The current readings will not be automatically refreshed.  You will have to use the browser 
refresh function on you cell phone. 

-For Vodaphone mobile phones, it is forbidden to use any port number other than 80. 



Checking and Making Changes to Computer 
Network Settings

If some network environments, it may be necessary to make changes to the IP address 
and subnet mask at the computer side in order to carry out a search.

See the following procedures for checking and making changes to your computer network 
settings.

1. In the [Control Panel], open [Network Connections].

2. Select the Network adapter that you are using, and right click with the mouse and open 

the Properties. 

3. Under the [General] Tab, in [This connection uses the following items:] select [Internet 

Protocol (TCP / IP)] and Click on [Properties] button. 

Check Internet Protocol 
(TCP / IP)

[Properties]
button



4. In the [Internet Protocol (TCP / IP) Properties] window, under [Use the following IP 

address:] make sure that the IP address and Subnet Mask are correct .

Check to make sure 
that the IP address  

and Subnet mask  
are correct.

5. In order to return the settings back to the original ones make sure to write down 

the current settings for IP Address , Subnet Mask , Default Gateway , 

Preferred DNS Server  and Alternate DNS Server . 

6. Enter "192.168.1.1 " as the IP Address and "255.255.255.0" as the Subnet Mask.  

IP Address: 192.168.1.1 / Subnet Mask: 255.255.255.0

7. After entering, click the [OK] button. 

8. Click the [OK] button as seen in the 8.3 Properties window to close the window. 

9. Once again, in the [Network Settings Utility] run a search and check whether the IP 

address for the RTR-5W connected to the network is displayed. 



10. If it is displayed properly, make the initial network settings. 

11. After making the initial network settings, follow steps 1-4 above to open the [Internet 

Protocol (TCP / IP) Properties] window. Re-enter the IP address , Subnet mask , 

Default Gateway , Preferred DNS server , and Alternate DNS server  that 

you had written down before and click the [OK] button.

12. Open the browser, enter the address (URL) that you set in the settings utility and 

check to make sure that the display is proper or not. 

*If you are using a company network or are working in an environment that may have special settings and 
after having followed the above procedures still cannot view the display properly, please connect your network 
administrator.    



Downloading JRE

To view graphs in your browser, it is necessary to have Java Runtime Environment (JRE) 
installed on your computer.

If you do not already have it installed on your computer, please download as follows.

NOTE:

- The installation of JRE is completely the responsibility of the user. 

- The following information is true as of February, 2006. Changes may occur to 
the version of JRE and hence exe. fi le names may also change. Please be sure to 
download and install the latest version.

1. Please enter http://java.sun.com/ in your browser s address bar; this will take you to 

Sun Microsystems Homepage.

2. Under Popular Downloads click on [J2SE 1.42 SDK].



3. Scroll down to fi nd [J2SE v 1.4.2_10 JRE ] and under that click on [Download J2SE 

JRE]. This will open the download window.

4. The JRE User's Agreement will appear. Scroll down while reading the agreement and 

click  "Accept" and [continue].



5. Under [Windows Platform - Java(TM) 2 Runtime Environment, Standard Edition 

1.4.2_08] click [ Windows Offl ine Installation, Multilanguage [j2re-1_4_2_08-windows-

i586-p.exe].

6. Click the [Save] button. 

[Save]
button

7. Specify the Location of the Folder for the download, and click the [Save] button to start 

the download.

Once the download is fi nished, double click on the downloaded Install Program [j2re-

1_4_2_08-windows-i586-p.exe] and the installation will begin.



Re-installing

Before reinstalling or updating the [RTR-5W for Windows] software, make sure to carry 
out the uninstall program fi rst. Also, before uninstalling, make sure to quit all RTR-5W for 
Windows applications.
* To install [RTR-5W for Windows], it is necessary to have Administrator rights (Computer 

Administrator) for the computer in which you wish to install it. 

1. In the Windows Control Panel, click on [Add/Remove Programs].

2. From the list of currently installed programs, select [RTR-5W for Windows] and click the 

[Add / Remove] button. 

3. The [Install Shield Wizard] will appear.  Check [Remove], and click [Next].

Check Remove

[Next]
button

4. Follow the directions to Uninstall.

5. After the uninstall process is completed, reinstall by following the directions to [Install].

- Even after uninstalling, saved data fi les will still remain in the folders and locations 

they were saved in.



Troubleshooting

Network Settings Utility

Q.1 The following message appears "Windows Security Alert" what should 
I do? 

A If you are using Windows XP SP2, the following message may be displayed.

There is no problem, so please click [Unblock].

Q.2 Is it possible to use the [Network Settings Utility] via a proxy server? 

A Communication is impossible via a proxy server.  With Web Viewer communication is 

possible. 

Q.3 I cannot run a search in the Network Initialization. Why?

A One of the following may be the reason:

Power is not being supplied by the AC adaptor to the RTR-5W

The RTR-5W and the computer you are using are not on the same network.

The [Network Settings Utility] is already being used by another computer.

The LAN card which is being used has not been formatted.

Q.4 I cannot make settings in the Network Initialization, Why ?

A One of the following may be the reason.
The Login ID and / or Password are incorrect.
Another RTR-5W with the same IP address is on the same network.

Q.5 Why does a "Communication Error (Connection Error) " appear ?

A The network is probably not properly connected.
One of the following is incorrect: IP address or Domain, Login ID, Password, or Port 
Number.
The network is not properly connected (the LAN cable is broken, the Hub is damaged, a 
mistake occurred in setting up the router, etc…)
In the "Menu"- " Communication Time Settings" try slowing the communication time.



Q.6 Because of some other [Communication Error] communication cannot 
occur. Why?

A One of the following may be the reason:
- The IP Block setting is ON and communication can occur with only specifi c PC’s.
- If after several attempts a communication error continues to occur, turn OFF the RTR-

5W and restart.
- A warning report mail or test mail may be in process. If a sending error occurs, 

processing takes time, so please wait for at least one minute before trying again.

Q.7 Which has priority, a wireless LAN or a wired LAN ?

A If a wireless LAN card is inserted, the wireless LAN will have priority. Because of this, if 
the wireless LAN settings are incorrect and a wired LAN is connected, communication will 
not take place via the wired LAN and hence communication will not occur.

Q.8 I forgot the password, what should I do ?

A First, return the settings to the factory default settings and then redo the settings.

Q.9 Is it possible to hide the IP address history and settings history ?

A If you wish to disable  the History, in the "Menu", select [Login History] and click to "OFF".
Please note that a history will remain viewable from when before it was disabled. To erase 
a history, please click on "Clear Login History" in the Menu.



Q&A about RTR-5W

Q&A about RTR-5W

Q.1 RTR-5W units use an AC adaptor, what happens when there is power 
shortage?

A During a power shortage the Web Server will not function and communication via LAN 

cannot occur.

If SNTP settings have not been made, the clock will reset. 

The data fi les for transfer will be erased.

All warning occurrence logs stored in the RTR-5W will be erased.

Q.2 Can I connect directly to my computer with the LAN cable that comes 
with the logger ?

A To connect a RTR-5W logger directly to your computer, you must use a cross LAN cable.
The LAN cable supplied is a straight LAN cable and cannot be used to connect directly to 
your computer.
Please purchase a cross LAN cable at your local computer supply store.

Q.3 Does the RTR-5W have a clock and calendar?

A The RTR-5W has an internal clock (calendar) built into it.

If the internal clock settings for the RTR-5W are not set correctly, the date and time in 

the RTR-5W Web Viewer’s current readings monitor and the time of warnings will also be 

incorrect. Make sure to set correctly before using.

NOTE:

If you make clock settings manually, the clock will lose its settings upon removal of 
the AC adapter or after restarting the system.

Q.4 It is possible to connect the RTR-5W to the network by using the LAN 
cable that connects the computer to the LAN network?

A Inserting the wireless LAN card that connects the computer to the network into the RTR-

5W will physically connect the RTR-5W to the network, but without making the necessary 

settings such as IP address, the RTR-5W cannot be active in the network and hence is not 

really connected. 

After having inserted the LAN cable, make sure to go to [Network Settings Utility] to make 

the necessary IP address and subnet mask settings. 



Q.5 It is possible to connect to a wireless LAN by removing the wireless 
LAN card from my computer and using it?

A It is necessary to make Wireless LAN settings.

In [Network Settings Utility], under [Detailed Network Settings] make changes to the 

[Wireless LAN Settings]After that, turn OFF the RTR-5W power, then insert the card and 

turn the power back ON.

Q.6 I want to use a wireless LAN, which products should I use ?

A Please use only those CF type Wireless LAN cards that have been proven to be compatible 
and are suggested for use.

Q.7 Which has priority, a wireless LAN or a wired LAN ?

A If the Wireless LAN is connected properly and all settings are correct, the Wireless LAN will 
have priority.

Q.8 I want to have a mail sent when a warning occurs, how can I do this ?

A To use the warning mail function, it is necessary to have an SMTP server.
If you have an Internet connection, use the mail server of your Internet service provider or 
some other means to access a mail sever. If you have a mail server on your company LAN, 
there may be specifi c instructions and settings for sending mail. Please ask the network 
administrator at your company for details.

Q&A about  Web Server Functions

Q.1 Are the RTR-5W Base Stations web servers?

A The RTR-5W stations have web server functionality built into them.   This function allows 
for the provision or serving up of temperature and humidity data, current readings and 
graphs. 

Q.2 What is a Web Server ?    What is a client ?

A In a computer network, the computer that acts as a provider of services to various users 
is called a server and the computers which request these services from the server are 
referred to as clients. 
Most communication service is made up of exchanges between servers and clients.
In the case of RTR-5W, the RTR-5W provides functions and information so it is a server 
and the computer, which reads this information or functions, is the client. 
For example, the storage of homepages and the making public of these are done by the 
[Web Server] and the sending and receiving of e–mail is preformed by the [Mail Server].



Q&A about Viewing the Web Site

Q.1 Can I use a RTR-5W logger without connecting it to a network ?

A If the RTR-5W is not connected to a network, the downloading of recorded data, the 
display of current readings, recording settings and all other types of settings cannot be 
carried out. 

Q&A about Networks

Q.1 What is a network ?

A A network is a system in which a group of computers are connected by cable (copper wire, 
optical fi ber, etc), infrared ray, radio waves or other means in order to share and exchange 
information.

There are basically two types of computer networks.
A Local Area Network or LAN consists of a group or network of computers in a limited range.

A Wide Area Network or WAN is a network of computers that are connected over long distance. The 
Internet is an example of a WAN that has connected a multiple number of networks. 

Q.2 What is an IP address ? 

A In a network, in order to distinguish your computer from another it is necessary to assign a 
number; this number is called an IP address.
When you connect to an outside network such as the Internet the IP address that is used is 
referred to as a "Global IP address. In a Local Area Network the IP address that is used is 
called a “Private IP address".
An IP address is divided into 4 blocks of numbers separated by periods, such as 
"192.168.15.10". The assigned numbers can use the digits 0-255 with private IP addresses 
usually beginning with numbers such as "192.168.".

However, the number "255." is not usually used.

This number is absolutely necessary to enable participation in a network, so it is necessary 
to set the IP address to a number that suits your network environment.



Q.3 What is a Subnet mask ?

A An IP address is made up of the network address to which the computer belongs (network 
address) and the computer’s own address within the network (host address). The Subnet 
mask determines the division between these.

The Subnet mask, similar to the IP address, is made up of four blocks of numbers divided 
by periods, such as “255.255.255.0”.
This number is absolutely necessary to enable participation in a network, so it is necessary 
to set the Subnet mask to a number that suits your network environment.

Q.4 How should I make settings for the IP address / Subnet mask ?

A
The IP address and Subnet mask settings vary depending upon your networking 
environment (structure). Please consult your network administrator for details. Below is a 
simplifi ed explanation of a company LAN set up for your reference.

If the computer connected to your company LAN has a Subnet mask of "255.255.255.0" 
and an IP address of "192.168.100.1", set the Subnet mask to the same as your computer, 
"255.255.255.0".
Set the IP address to 192.168.100.***. Make sure to set the last three digits,***, to a number 
between 1-254 that is not the same as any other computer connected in your network.

Q.5 What is a MAC address ?

A A MAC address is a unique number made up of alphabet and numbers that is assigned 
separately to the components of network communication (computer, server, router, etc…). 
Each MAC address is assigned to the hardware and is unique to that device, so there is no 
chance for duplication.
If you compared it to a cell phone, even though the phone number may be changed, 
you could think of the MAC address as the serial number of the phone, which cannot be 
changed and is unique to each unit.
The MAC address is written on a sticker on the back of each TR-7W logger.



Q.6 What is a port number ?

A When using TCP/IP communication with a LAN cable or via a phone line, port numbers are 
assigned to distinguish one application from another.
Port numbers can be assigned from 0 to 65535. The numbers 0 to 1023 are already 
reserved to communication services and are referred to as "Well Known Port Numbers".
[Well known port numbers] are: HTTP communication at 80 / FTP communication at 20 and 
21 / SMTP communication (sending mail) at 25 / POP3 communication (receiving mail) at 
110.
In order for communication to work properly these port numbers must be set correctly.

Q.7 What is a gateway ?

A A gateway is a term used to refer to a device or software that is used to link networks with 
different standards.
For example, a gateway is needed when connecting a cell phone to the Internet or in any 
case where you wish to connect two devices that are completely different. Gateway carries 
with it the meaning of entrance and exit and a router may also be referred to with this term.
When making gateway settings, it is necessary to make IP address settings for the device 
that will act as a gateway.

Q.8 What is a URL ?

A A URL is an address that is written in a way so that it is easy for the DNS function to 
determine on which server the IP address is located.
This address begins with "http:// " and is followed by such things as domain names, server 
names, port numbers, fi le names and other such info.

For example, if the IP address that is assigned to "www.tandd.com" is "61.197.203.107", 
by entering "http://61.197.203.107/product/wdr_3/tr_7w_01feature.html" in the browser, 
the same page will appear as when you enter "http://www.tandd.com/product/tr_7w/
tr_7w_01feature.html".

The DNS or Domain Name Server helps to switch difficult to understand IP address of just 
numbers, such as "61.197.203.107" into easy to grasp names such as "www.tandd.com" and 
helps connect to the desired server.



Q&A about the Internet

Q.1 What is a fi xed IP address?

A Usually, when you connect to the Internet, the provider with which you have contracted 
service automatically assigns an IP address which may be different each time you connect, 
or may change after a certain length of time. 
With this type of changing IP address, it is more diffi cult for outsiders to illegally enter your 
computer.  On the other hand, when using your computer or a RTR-5W unit as a sever, 
it would be necessary to enter a different IP address as the URL each time you wish to 
access it.  In such a case, it would be necessary to fi nd out the current IP address each 
time you wished to access and this would be totally inconvenient. 
To help solve this problem, there is something called a fi xed IP address service that your 
provider can offer.  
With a fi xed IP address, you will be assigned a special unique IP address. 
Some providers may give you a fixed IP address from the beginning of service, but with 
most providers it is necessary to sign up for this special service.

Q.2 How do you get a fi xed IP address?

A A fi xed IP address is a service offered by your Internet provider. 
For details about how to receive a fi xed IP address contact the Internet provider with which 
you are connected. 

Q.3 How should I set up a fi xed IP address?

A If you are using only one RTR-5W connected to one router, then the fi xed IP address should 
not be set for the RTR-5W, but for the router. If you are using a multiple number of RTR-
5W connected to one router, the RTR-5W will use FTP and HTTP so, please set a fi xed IP 
address for each RTR-5W unit. 
Because it is impossible, when using normal ADSL or FTTH lines, to directly connect the 
RTR-5W to the Internet line, it is necessary to place a router between the logger and the 
ADSL (FTTH) modem. 
When using a router, the fi xed Internet IP address should be assigned to the router and 
all access to the RTR-5W from outside should go through the router.  In this case, the 
router will have two IP addresses: an external IP address for the Internet and an internal IP 
address for the company or household LAN. 



Q.4 I want to use a URL without a fi xed IP address, how can I do that? 

A If you wish to access an RTR-5W by URL but without a fi xed IP address, it is possible to 
use a dynamic IP address.
The DNS or Domain Name Server helps to switch diffi cult to understand IP address of just 
numbers, such as "61.197.203.107 " into easy to grasp names such as “www.tandd.co.jp” 
and helps connect to the desired server.   
The DNS usually changes names to fi xed IP addresses. 
But, if for some reason you cannot use a fi xed IP address or for security reasons you wish 
not to use a fixed IP address, there is a type of DNS called a dynamic DNS, which can 
handle ever-changing IP addresses. 
For example, the starting IP address is "210.0.0.1 " and the URL associated with it is “http://
www.rtr5w.com”.
The IP address "210.0.0.1 " is of the changing type that is periodically reassigned by the 
provider.  After a certain period of time the assigned IP address is changed to "210.0.0.2 ".
Normally, at this point the DNS would not associate the URL with the IP address and 
access would be made impossible, but because the dynamic DNS tracks the IP address 
you can still access the desired server using the same URL. 
There are many types of dynamic DNS plans and services available, please contact your 
local provider for more details. 

Q.5 Can I use the Warning Mail function without getting or using a fi xed IP 
address?

A If it is possible for you to connect to the Internet by using a dynamic DNS, theoretically it 
is possible to send mail without having or using a fi xed IP address. That is presuming it is 
possible to successfully send data via your provider’s mail sever or your company’s mail 
server. 
Fundamentally, if you are able to access your company mail server or connect to the 
Internet it should be possible to send mail. 

Q.6 Is it possible to connect to the Internet without a fi xed IP address or an 
URL ?

A Yes it is possible to connect without using a URL or having a fi xed IP address, but because 
the IP address that will be assigned by the provider will be constantly changing, the access 
will be varied and will not go smoothly.
For example, the IP address that you used successfully one hour before may no longer 
work and access will be made impossible. Further, you will have no way of verifying the new 
IP address.
We strongly suggest using either a fi xed IP address or a dynamic DNS.



Q.7 Is it possible to connect to the Internet without a fi xed IP address nor an 
URL? 

A Yes it is possible to connect without using a URL or having a fi xed IP address, but because 

the IP address that will be assigned by the provider will be constantly changing, the access 

will be varied and will not go smoothly. 

For example, the IP address that you used successfully one hour before may no longer 

work and access will be made impossible. Further, you will have no way of verifying the new 

IP address. 

We strongly suggest using either a fi xed IP address or a dynamic DNS.



Specifi cations

Web Wing WL  RTR-5W

Compatible devices RTR-51, RTR-52, RTR-53, RVR-52A

Operational Status 
Display 

LED Lamp Display ( Power ON / Wireless Communication in Progress / Warning Occurrence)

Power Specifi c AC Adapter

Communication Method Wired LAN: 100 BASE-TX / 10BASE-T (RJ45 Connector)Wireless 
LAN: IEEE802.11b (CF Wireless LAN Card) *1

Communication Speed Special short wave radio wireless: 2000 readings per minute / Optical Communication: 
2400bps

Communication Time When downloading data from Data Logger with RTR-5W via wireless communication (1 unit 
of full data takes about 420 seconds)

External 
Output(Warning Output)

When operating the warning functionVoltage when OFF: AC/DC less than 50V / Current when 
ON: less than 0.1A / ON Resistance: MAX 35

Dimensions / Weight of 
Main Unit

H83 W102 D28 mm excluding protrusions   / abuot 137g

Operating Environment Temperature: 0 50  / Humidity: 20 80 RH (without condensation)

Accessories included in 
package

AC Adaptor AD-0605 x 1 / LAN Cable LN-20W x 1
Software Set / Introductory Guide and Warranty x 1

*  For information and updates concerning which wireless LAN cards can be used please see our Homepage.

PC Operating Environment

OS
PC/CPU
Memory
Hard Disk
Monitor
LAN

Browser

Micrsoft Windows®  2000/XP *1

A Stable Windows Operating Environment
Enough memory to stably operate Windows
More than 10 MB of free space Data will need more space
SVGA higher than 800 600 recommended more than 256 colors
100BASE-TX or 10BASE-T
Twisted pair cable confi rming to Category 5 STP/UTP
Internet Explorer 6.0 or higher

*1 For installation, it is necessary to have Administrator (Computer Administrator) rights.  

RTR-5W for Windows®

RTR-5W for Windows

Compatible 
devices

RTR-5W

Functions Remote Unit Registration, Recording Start / Stop, Download Data, Auto-Download Settings, 
Warning Report Settings, Gather Current Data, Data Transfer, View Remote Unit Battery Level

Network Settings Utility

Compatible 
devices

RTR-5W

Functions Network Initialization Settings, Detailed Network Settings.



Temp / Humidity Graph 

Compatible devices RTR-5 Series, TR-71W / TR-72W TR-7 Series TR-5 Series RTR-7 Series Data Loggers

Number of Channels 8 Channels Simultaneous Display / Processing

[Screen Display]
Graph

Data

Other Functions

Temperature / Humidity Graphs for every Channel Zoom in/out and scroll with mouse or 
keyboard, Change Display Colors for Channels, View/ Hide Channels

Channel Name, Recording Interval, Number of Data, Highest, Lowest and Average, Unit of 
Measurement,  A and B Cursor Dates/Times and Temp / Humidity Readings, Calculated Temp 
/ Humidity Difference between Cursor A and B

Data List Display, Calculation Range (Time Period) Settings, Data Maintenance, Delete Data by 
Channel, Re-order Data by Channel, Vertical Scale Settings

File Output Special T&D Data File Text File CSV, etc

Printing Graphs / Tables

Multi-scale Graph

Compatible devices RTR-5 Series, RVR-52A, TR-71W / TR-72W, TR-7 Series, TR-5 Series, RTR-7 Series Data 
Loggers

Number of Channels 8 Channels Simultaneous Display / Processing

[Screen Display]
Graph

Data

Other Functions

Data Graphs for every Channel Zoom in/out and scroll with mouse or keyboard, Change 
Display Colors for Channels, View/ Hide Channels

Channel Name, Recording Interval, Number of Data, Highest, Lowest and Average, Unit of 
Measurement,  A and B Cursor Dates/Times and Measurements, Calculated Differences in 
Measurements between Cursor A and B

Data List Display, Calculation Range (Time Period) Settings, Data Maintenance, Delete Data by 
Channel, Re-order Data by Channel, Vertical Scale Settings

File Output Special T&D Data File Text File CSV, etc

Printing Print Data List

Event Viewer

Compatible devices RVR-52A (for Recorded Event Time Data)

Number of Channels 64 Channels Simultaneous Display / Processing

[Screen Display]
Data List

Other Functions

View Event Time Data List for Each Channel (Zoom in/out and scroll with mouse or keyboard), 
View Rising (Lo to Hi) Waves and Falling (Hi to Lo) Waves

Change the LCD Display , Shift between Descending/Ascending

File Output Special T&D Data File Text File CSV, etc

Printing Print Data List

About the RTR-5W Series Web Viewer
Compatible devices RTR-5W

Functions Monitor Current Readings, View Graphs



Options

AC adapter for RTR-5W

AD-0605 AC adapter

RISK OF ELECTRIC SHOCK
DRY LOCATION USE ONLY.
SHOCK HAZARD NON-
SERVICEABLE PARTS INSIDE.

Wall Attachment Unit for RTR-5W
TR-5WK1 Wall Attachment

Temperature Sensors For TR-52/RTR-52  unit: millimeters

TR-5106 Tefl on-Shielded Sensor
Cable Length

Thermal-

Constant Time

0.6m

Approx. 15 Sec. (in air)

Approx. 2 Sec. (in agitated water)

TR-5101 Tefl on-Shielded Sensor
Cable Length

Thermal-

Constant Time

45mm

Approx. 15 Sec. (in air)

Approx. 2 Sec. (in agitated water)



TR-5220 Stainless Protection Sensor
Cable Length

Thermal-

Constant Time

2.0m

Approx. 36 Sec. (in air)

Approx. 7 Sec. (in agitated water)

TR-5320 Stainless Protection Sensor
Cable Length

Thermal-

Constant Time

2.0m

Approx. 12 Sec. (in air)

Approx. 2 Sec. (in agitated water)

TR-5420 Stainless Protection Sensor
Cable Length

Thermal-

Constant Time

2.0m

Approx. 12 Sec. (in air)

Approx. 2 Sec. (in agitated water)

Thermistor Stainless pipe (SUS316) Tefl on Compaction Tube Tefl on Resin (FEP)-Shielded

Possible Measurement Range

Sensor Temperature Durability

Measurement Accuracy

Water Resistance

-60 to 155

-70 to 180

Average 0.3 (-20 to 80 ) Average 0.5 (-40 to -20 / 80 to 

110 )

Average 1.0 (-60 to -40 /110 to 155 )

Splash Proof (Sensor and Cable)



Temp / Humidity Sensor For RTR-53                                    unit: millimeters

TR-3310 Temp / Humidity Sensor
Cable Length 1

Temperature/Humidity sensor Polypropylene resin Vinyl Coated Electrical Wire 

Possible temperature 

measurement range

Possible Measurement Range

Sensor Temperature Durability

humidity measurement 

accuracy

Service life

Operational conditions

10 to 95 RH

0 to 50

-10 to 55

 5  RH (at 25  50  RH)

1 year (under normal operational conditions)

Without dew condensation, water leakage or effect from corrosive gas or 

organic solvents.

Input Cables For RVR-52A   unit: millimeters

RPR-7101 Pulse Input Cable
Cable Length 1.5m

RVR-5203 4-20mA Probe Cable
Cable Length 1.5m

M3.5 Tongue Terminal M3.5 Tongue Terminal Connector

VR-2C10 Sensor Extension Cable (to Moisture Sensors)
Cable Length: 1.0m

Vinyl Coated Electrical Wire



Sensor Extension Cables For RTR-52                 unit: millimeters

TR-2C30 Sensor Extension Cable
Cable Length

Waterproof Capacity

3

Splash Resistant

Sensor Extension Cables

NOTE:
Only one cable per sensor.

When using the extension cable there will be a +0.3  at normal temperature and at -50  a gap of +0.5  

may occur.

Power For RTR-5/RVR-5                                                   unit: millimeters

RTR-05A1 External Power Adaptor
Voltage Input

Back-up Power

Back-up Time

Changing Method

Operating 

Temperature

Waterproof Capacity

Weight 

Contents

DC6V DC13V

Ni-MH Battery (In case of power loss)

4 days (*1)

Trickle Charge

0 to 60

none

about 37g (without AC Adaptor)

Attachment hook x 1

Rubber Packing x 1 (for back of main unit)

Rubber Packing (small) x 1(for AC Adaptor jack)

Silica Gel Pack (drying agent) x 1

Double-sided Adhesive Tape x 1

(for fastening silica gel)

Screws x 2

(extras for fastening back of main unit)



RTR-05B1  Large Capacity Battery Pack
Power

Battery Life

Waterproof Capacity

Operating 

Temperature

Weight

Contents

Lithium Battery x 1 (LS26500)

about 2 years and 6 months (*1) 

(Monitoring at 1 minute interval = about 20 

months)

Splash proof

-40 to 80 2

about 75g (including lithium battery)

Attachment hook x 1

Rubber Packing x 1 (for back of main unit)

Silica Gel Pack (drying agent) x 1

Double-sided Adhesive Tape x 1 

(for fastening silica gel)

Screws x 2

(extras for fastening back of main unit)

*1: Battery Life varies depending on measuring environment, recording interval, transmission 
frequency, and ambient temperature. Specifi cations and explanations used in this User's Manual 
are based on operations carried out with a new battery and are in no way a guarantee of your actual 
battery life.

*2: Operating temperature depends on the specifi cations for the data logger being used.

Power For TR-5/RTR-5/RVR-5

TR-00P1 Maintenance Set
Contents Rubber Packing x 1 (for back of main unit)

Silica Gel Pack (drying agent) x 1

Double-sided Adhesive Tape x 1 

(for fastening silica gel)

Screws x 2 

(extras for fastening back of main unit)

TR-11P2 Low-Temperature Battery Set
Contents Lithium Battery x 1 LS14250

Tube x 1 

Maintenance set x 1 TR-00P1



Wall Attachment For TR-5/RTR-5/RVR-5                              unit: millimeters

TR-00K2 Wall Attachment
Compatible devices RTR-5/RVR-52A/TR-5

Aluminum Neoprene

TR-05K1L Wall Attachment
Compatible devices For use with Data Loggers 

RTR-5L / RVR-52AAL or 

RTR-5 / RVR-52AA / TR-5 in 

conjunction with RTR-05A1 

Adaptor or RTR-05B1 Battery 

Pack

Aluminum

TR-05K2 Wall Attachment
Compatible devices RTR-5/RVR-52A/TR-5

ABS Resin



5652-169, Sasaga, Matsumoto City, Nagano, 399-0033 Japan

Tel: +81-263-27-2131     Fax: +81-263-26-4281

E-mail: overseas@tandd.co.jp

Offi ce Hours : Monday to Friday 9:00-12:00/13:00-17:00

(GMT +9:00 Tokyo Time)

[Home Page]

We have opened an English Homepage called "T&D Online" for your

convenience. Here you can fi nd information about our company, news,

products, upcoming events, software and user's guides downloads, as well

as, other support. Please stop by and see what we have to offer.

http:/ /www.tandd.us/
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